
Childcare Manager 
Getting Started Guide

version 10.1.6483



Copyright 2002-2017 Personalized Software, Inc.

All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or
mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the
written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the
respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no
responsibility for errors or omissions, or for damages resulting from the use of information contained in this
document or from the use of programs and source code that may accompany it. In no event shall the publisher and
the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused
directly or indirectly by this document.

Childcare Manager 10.1.6273

Persoft Inc. 
P.O. Box 359 
Phoenix, OR 97535-0359
(800)-553-2312
www.childcaremanager.com





4Contents

4

Getting Started Guide

Persoft Inc. Copyright 2017

Table of Contents

Introduction 5

Part I Install and Register Childcare Manager 6

Part II Create a New Center 7

Part III Navigating Childcare Manager 8

Part IV Entering Information into Your Center 10

Part V Classroom and Program Lists 12

Part VI Schedules, Attendance and Timesheets 14

Part VII Billing and Receiving 19

Part VIII Report Center 27

Part IX Additional Features 30



Introduction

Welcome to Childcare Manager, the premier and easy to use program designed
to help you manage your childcare facility. Childcare Manager simplifies the
process of running your childcare facility by organizing all of your important
information in one place. This guide will explain how to create and setup a new
center and then use the basic functions you need to run your childcare facility. 

If at any time you need a more in-depth explanation on something, or you just
want to learn more about the program, you can visit the in-program help by
pressing F1 or clicking the help button. We also offer a free support program for
our first year customers, which includes phone and email support as well as
scheduled phone training. All of our contact information and pricing for future
support is available on our webiste Childcaremanager.com.
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1 Install and Register Childcare Manager

Childcare Manager runs on the Microsoft Windows ® operating system and currently supports all
editions of Windows Vista, Windows 7, Windows 8.1, and Windows 10.

After you purchase Childcare Manager, you should receive an e-mail from your salesperson. In the e-
mail, you will find a serial number and link to a website. 

To install Childcare Manager:
1. Open the e-mail and click the website link.

a. You can also visit Childcaremanager.com, hover over the Support menu and select Downloads.

2. Enter your serial number in the Serial Number box.

3. Download the latest version of Childcare Manager and Run the setup.
a. If you are missing any necessary software to run Childcare Manager, a window will appear asking if

you want to download these updates. Click OK.

4. Follow the instructions in the Childcare Manager 10.1- Install Shield Wizard window.

5. After Childcare Manager is installed the Childcare Manager Registration window will open.
a. Choose either the Preview option or the Purchased option and click Next.

6. If you choose the Preview option you will be allowed to use the Demo Daycare account:
a. The Demo Daycare account is a great way to not only demo Childcare Manager, but also practice

using many of the functions Childcare Manager offers.
b. The Demo Daycare account can be used for an unlimited amount of time, but each time you

reopen the account the dates are reset.

7. If you choose the Purchased option you will open the User Account Control window:
a. The Demo Daycare account is also available in the Purchased option.

8. Click Yes and enter your serial number in the Serial Number box in order to register your copy of
Childcare Manager.

9. Follow the remaining steps in the Childcare Manager Registration window and click Finish.
a. If you want to register your version of Childcare Manager at a later date, you can select the

Register option in the Help menu.

10.Congratulations you have successfully installed Childcare Manager.

Please note that if you are installing a Multi-User version of Childcare Manager, the installation process
is the same. 

http://www.childcaremanager.com/
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2 Create a New Center

Now that you have installed and registered Childcare Manager, it is time to create and setup your
center. 

1. Select New Center from the File menu.

2. In the Center Wizard window enter your information:
a. You only need to add a Center Name to create a new center.

3. Click the  button and select the Center Properties and Data tab. 

4. Click the Center Information toggle:
a. This section includes more detailed information than the Center Wizard window. It is best to fill out

as much information as possible in the beginning so you don't have to go back and do it later. Don't
forget to add your tax ID numbers, so your parents have the information they need for year-end tax
preparation.

5. For further customization fill out the information in the Contact Information toggle.

6. Finally, make sure to create a backup of your center on a USB drive or other external source.
a. Childcare Manager offers an online solution to make sure your data is safe and up to date. For more

information on CCM Online Backup, you can contact our customer service or visit the Childcare
Manager Online website.

http://www.childcaremanager.com/contact.aspx
https://www.childcaremanageronline.com/
https://www.childcaremanageronline.com/
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3 Navigating Childcare Manager

Childcare Manager is divided into one general center called My Center, and seven specific centers. My
Center gives you general information about your childcare facility, and it is also the start window for
Childcare Manager. The seven other centers give you specific information about each aspect of your
childcare facility. Each center follows a common format, which reduces the time to learn Childcare
Manager and simplifies using the program.

The common features found in most centers are highlighted in the figure below.

1- Title Bar displays the name of your program and the name of the center that is open.

2- Menu Bar contains multiple drop-down menus that provide access to all of your program
information, transactions, tasks and reports. Most items found in the Menu Bar are accessible
through the centers. The primary exceptions are items in the File menu and the Help menu.

3- Centers Bar provides you with access to each center. The Centers Bar also includes an
Emergency button that can be used to printout a roll-call sheet for fire drills and other emergencies.
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4- QuickView provides you with important information about the individual, agency or account
highlighted in the Names List. More detailed information about the individual, agency or account is
located in their data card.

a. Data cards are accessed by double clicking on the name in the Names List or the name
in the QuickView, or by clicking the edit button on the QuickView toolbar.

5- Work Area displays the accounting journals and several other working screens including
contacts, notes, schedules, and attendance records.

6- Quick Bar lets you access the Names List, Tasks List and Reports List.

7- Names List is a list of all the families, children, accounts, employees and other payers for the
open center. In addition, the family and other payer lists provide an account balance for each family
and other payer listed. The child list provides an immunization icon for each child with an overdue
shot. An option is available in User Preferences that allows you to remove this icon or to replace it
with one of the other three QuickFlag icons (Allergies, Pickup or Medical).

8- Tasks List is a list of tasks for the open center.

9- Reports List is a list of report categories for the open center. When you click a category, a list of
reports in that category are displayed under the Names List. To run a report, double click on it.

10- Configure Buttons is a pop-up menu that gives you the option to add or remove tasks from the
Tasks List or reports from the Reports List. The Reports List is hidden by default.

11- Status Bar displays a variety of useful information within the program including:

a help message on the far left that describes the function your mouse is hovering over.

the initials of the logged in user in the User field . When no one is logged in the letters N/A
(none available) are displayed.

the date of your last backup in the Last Backup field. 

a display that tells whether or not the list you are viewing is filtered. 

a count of the names in the Names Lists of the open center. 
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4 Entering Information into Your Center

Childcare Manager makes it easy to enter important information about the people and the finances
involved with your childcare facility. For the most part it is as simple as filling in a form. 

Above is a screen-shot of the Family Data window, which is where you enter information about a child's
sponsors. The Family Data window is similar to the Child Data, Employee Data, Other Payer, Family
Contacts and Lead Information windows. Each window contains important fields, where you fill out the
necessary information about the individual. The more information the better, but in most cases you can
add someone into your database with just a name and a status. Although entering information is often a
simple process, the rest of this section will focus on some guidelines and tips that will help you along
the way. 

Guidelines and Tips:
1. There are three simple ways to add someone into your database:

a. Click the Add button in the QuickView.

b. Go into the Names List, right click and choose the Add option.
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c. Select the Add option from the Center's Menu Bar.

2. Once you have added someone into your database you can edit their information by highlighting their
name in the Names List and selecting the Edit option.
a. The Edit options are available in the same places as the Add options.

3. In many of the information windows, you will find Custom Field Buttons. These buttons open a
customize window where you can add your own fields to the existing drop down list.
a. Childcare Manager comes with numerous default fields for each drop down list.

4. Before you can Add a child into the Child Center you must Add their parent or Primary Sponsor
into the Family Center.

5. When you are Adding or Editing information in the Information window, if you click Apply that saves
the current information and lets you continue to Add or Edit. If you click OK that saves the information
and closes the window.

6. If at any time you have question about the current Information window, click the Help button at the
bottom right.
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5 Classroom and Program Lists

When you add a child into your center, you will want to assign them to a specific class or program. This
way you can run specialized reports as well as keep track of attendance, billing and so much more.
Childcare Manager has numerous classrooms and programs set up by default, but you may want to
change those lists in order to match the specific criteria and names of classrooms and programs in your
school.

The Classrooms Lists and Programs Lists are set up the same way, so if you learn how to use one list,
then you will be able to use the other. 

To Add a Classroom/ Program:
1. Click Lists in the Menu Bar.
2. Select Classrooms/ Programs.
3. Click Add and fill out the remaining columns:

a. Class/ Program Name: The name of the classroom or program.
b. Capacity: The maximum number of children allowed in a classroom or program.
c. Ratio: The maximum number of students per one teacher in that classroom or program.
d. Factor: Number used to determine the FTE of your childcare facility.

Only the Class/ Program Name must be filled out. All other fields are optional. 
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To Edit/ Delete a Classroom/ Program:
1. Click Lists in the Menu Bar.
2. Select Classrooms/ Programs.
3. Highlight the appropriate Classroom/ Program
4. Edit the information in the necessary column

OR
5. Click Delete and then OK in the Delete window.

You can also access the Classrooms window and Programs window by pressing the Custom Field
button next to the Classroom or Program drop down list in the Child Data window. 
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6 Schedules, Attendance and Timesheets

A crucial aspect of running a childcare facility is time management, and with Childcare Manager it is
easy to to keep track of schedules, attendance and timesheets. 

Schedules

The Schedules task is found in the Child, Employee and Lead Centers. The organization of the task
is the same for the Child and Employee Centers, but in the Lead Center the Schedules task is
catered more for a lead. 

To Create/ Edit a schedule in the Child and Employee Centers:
1. Open the Child or Employee Center.

2. Select the Schedules task from the Tasks Bar.

3. Highlight the child or employee whose schedule you want to create/ edit.

4. Click the  button at the top of the Work Area.

5. Fill out the Weekly Schedule window:
a. Select the week from the drop down calendar.
b. Click Create New Week.
c. Either enter the week in manually or you can load a weekly schedule template:

i. To enter the week manually:
1. Highlight the day
2. then enter the time, or use the scroll wheel on your mouse.

a. With two separate IN and OUT fields, you can factor break time into your schedule.
ii. To load a weekly schedule template:

1. Click the Load Template button.
2. Highlight the appropriate template.
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3. Click OK.

6. To save your new schedule click OK.

To Create/ Edit a Schedule Template:
1. Click Lists in the Menu Bar.

2. Select the Schedule Templates option.

3. To Edit a template highlight the template and click Details.

4. To Add a template click Add.

5. Fill out the Weekly Schedule window.

6. Click OK.

For more information on child and employee schedules, including how to add multiple schedules to one
employee or child, please visit Employee Tasks-Schedules and Child Tasks-Schedules in the Help
manual. 

The schedule in the Lead Center is designed to set up individual events, instead of an ongoing weekly
schedule. This helps you manage tours, phone calls and meetings with your various leads. The 
Schedules task in the Lead Center could also be used for your very own personal date book. You can
set up reminders, add locations to the event and even add extra notes.

To create/ edit an event in the Lead Center:
1. Open the Lead Center.

2. Select the Schedule task in the Tasks Bar.

3. Highlight the lead whose event you want to create/ edit.

4. To schedule a new event click the New Event button at the top of the Work Area.

5. To edit an event click the event in the Work Area and then click the Edit Event button.
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6. Fill out the Event window.
a. To create an ongoing event, click the Recurrence button.

For more information on lead schedules, including recurring events, please visit Lead Tasks-Schedule
in the Help manual. 

Attendance

There are two ways to take attendance in Childcare Manager. You can take individual attendance or
batch attendance for multiple children. 

To take individual attendance:
1. Open the Child Center.

2. Select the Attendance task in the Tasks Bar.

3. Highlight the child for whom you want to take attendance.

4. When the child arrives, click the  button at the top of the Work Area. 

5. When the child leaves, click the  button at the top of the Work Area. 

To manually enter or edit the clock in or clock out time:

1. Click the  button.

2. To add a new attendance record click Add.
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3. To edit an attendance record, highlight the record and click Edit.

4. Fill out the Time Entry window and click OK.

To take attendance for multiple children:
1. Open the Child Center.

2. Select the Batch Attendance task from the Task Bar.

3. Fill out the Batch Attendance window.
a. The Filters button opens the Child Filters window where you can filter the Batch Attendance list

by status, program, classroom and many more.

4. Click OK.

Timesheets

The Timesheets task for employees is very similar to the Attendance task for children. If you are
confident using the Attendance task, then the Timesheets task should be no problem. 

To use a timesheet:
1. Open the Employee Center.

2. Select the Timesheets task in the Task Bar.

3. Highlight the employee whose timesheet you want to edit.

4. When the employee arrives, click the  button at the top of the Work Area. 
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5. When the employee leaves, click the  button at the top of the Work Area. 

To manually enter or edit the clock in or clock out time:

1. Click the  button.

2. To add a new timesheet record click Add.

3. To edit a timesheet record, highlight the record and click Edit.

4. Fill out the Time Entry window and click OK.
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7 Billing and Receiving

Some of the most important aspects of a company are the finances. Childcare Manager's financial tools
are designed to streamline your billing and receiving of payments, so you can spend your time doing
more important things than book-keeping. 

Billing

Before you can bill a customer you need to create a list of goods and services your childcare facility
offers. Childcare Manager calls this the Charge and Credit Items list. The Charge and Credit Items
list comes with a number of default goods and services that include tuition, food and activities. These
items may or may not be useful to you, which is why they can be Edited or Deleted. 

To open the Charge and Credit Items list:
1. Click Lists in the Menu Bar.

2. Hover over Accounting

3. Select Charge/ Credit Items.
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To Add an item in the Charge and Credit Items lists:
1. Click Add to open the Item window.

2. Select the type of item from the Type drop down list:
a. A Charge is a good or service your customers buy from you.
b. A Credit is a discount or refund the customer receives from you.

3. Enter the name of the item.

4. Link the item to an account by selecting an account from the Account drop down list.
a. Childcare Manager comes with numerous default accounts. Accounts can be Added, Edited and

Deleted from the Chart of Accounts in the Accounting Center.

For more information on Chart of Accounts, please visit the Chart of Accounts topic in the Help
manual. 

5. Enter the cost of the item in the Default Amount box.
a. This amount can be changed when you add the charge or credit to a family account.

6. Enter the FTE (Full Time Equivalent) if necessary.

7. Click the Restrictions check box to add minimum and maximum amounts to the item.
a. Click the Allow Override with Password check box to make it possible to input amounts outside

the minimum and maximum amounts. The password is your User Initials and User Password.

For more information on how to set up User Initials and a Password, please visit the Protecting Your
Data-How to Utilize Users Manager topic in the Help manual. 

8. Make sure the account is Active and click OK.

To Edit/ Delete an item in Charge and Credit Items lists:
1. Highlight the item you want to Edit or Delete.

2. Click Edit to open the Item window.
a. Make the necessary changes.
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3. Click Delete and confirm you want to delete the item.
a. If the item still has journal activity, then you will not be able to delete it.

Now that you have an item list you can bill your customers. If you want to bill an individual for a one time
item the best way to do so is with the Enter Charge button. If you want to bill your customer for a
recurring charge like tuition, then you will want to use the Contract Charges task. 

To Enter a Charge:
1. Open the Family Center.

2. Select the Receivables task from the Tasks Bar.

3. Highlight the family you want to charge in the Family List.

1. Click the button at the top of the Work Area.

2. Fill out the Enter Charge Statement window and click Post.

OR

1. Click the  button at the top of the Work Area. 

2. Fill out each column in the Family Receivables ledger and click .
a. You can Edit or Void charges from the Family Receivables ledger by clicking the charge

and choosing the appropriate button from the top of the Work Area.
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To enter a Contract Charge:
1. Open the Family Center.

2. Select the Contract Charges task from the Tasks Bar.

3. Highlight the family you want to charge in the Family List.

4. Click the  button at the top of the Work Area.

5. Fill out the Edit Billing Item window and click OK.

The Edit Item Billing window:
The Edit Billing Item window is similar to the Enter Charge Statement window. The noticeable differences
are the Contract Charge Type option and the Cycle drop down list. 

1. Contract Charge Type option gives you two choices.
a. Charge/ Credit Item option lets you choose a charge or credit item from the item drop down list.

Charge/ Credit Items have a fixed price.

b. Billing Package Item option lets you choose a billing package item from the item drop down list.
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Billing Package Items have a variable price that changes based on the attendance hours of the
child. 

For more information on Billing Packages, please visit Billing Customers-How to Setup Billing
Packages topic in the Help manual. 

2. Cycle drop down list lets you choose the billing cycle of the Charge/ Credit Item or Billing
Package. To add, edit or delete a billing cycle press the Custom Field button next to the Cycle drop
down list.

Sometimes you may want to bill multiple customers at the same time. The easiest way to do this is by
using the Batch Bill task. 

To Batch Bill:
1. Open either the Family Center or the Accounting Center.

2. Select the Batch Bill task from the Tasks Bar.

3. Choose a Bill by option.
a. Batch Billing offers you many different ways to bill multiple customers at the same time. At the

top of the Batch Billing window is a brief description of the Bill by option.

4. Fill out the Batch Billing window and click Preview & Post.

5. A Batch Billing Preview window will open showing you all of the customers that meet the criteria you
specified in the Batch Billing window.
a. If there is an error with a customer, a Red Flag will appear next to their name. To view the error(s)

click the  button.

6. When you are satisfied with your batch bill click Post.

Receiving

After you bill your customers, you will need to be able to receive payments. Childcare Manager takes
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care of the difficult accounting for you, so all you need to do is enter the payment. If you have a Rapid
Tuition account, you will be able to process credit card payments, process check conversions and give
your customers the option of signing up for autopay. You can still use all the major accounting functions
of Childcare Manager without signing up for RapidTuition, but RapidTuition makes accounting much
easier. For more information on all the features included in RapidTuition, please visit the RapidTuition
section in the Help manual. To learn more about setting up a Rapid Tuition account, call Childcare
Manager customer service today. 

The first step when you activate your Rapid Tuition account is to enroll your customers so they can use
the service. 

To enroll a customer: 
1. Open the Family Center.

2. Highlight the family you want to enroll in the Family List.

3. Select the Rapid Tuition Family Enrollment task from the Tasks Bar.

4. Choose their Payment Type and enter their Account Information.
a. RapidTuition Autopay Options have default settings that can be changed. There is more

information on the Autopay Options at the top of the RapidTuition Family Enrollment window, or in
the Help manual in the section RapidTuition Family Enrollment.

b. The remaining fields are optional.

5. Review the information and click OK.

Now that you have a customer enrolled, you can receive their payments through RapidTuition. You can
still access the Receive Payments task without RapidTuition, but it acts more as a book-keeping
mechanism. With RapidTuition you be able to do receiving, making deposits and book-keeping all at
the same time. For the purposes of this guide, the Receive Payments task will be explained as if you
had RapidTuition. The only difference between the two is that those with RapidTuition will have more
options. 

To Receive Payments:
1. Open either the Family Center or the Accounting Center.

2. Select the Receive Payments task from the Tasks Bar.

http://www.childcaremanager.com/contact.aspx
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3. Select a customer from the Customer drop down list.

4. Select a payment type from the Payment drop down list.
a. If you want to use a credit card stored through Rapid Tuition, enter the credit card information, or

to swipe a credit card using Rapid Swipe press the  button.

b. If you want to process a check, press the  button and scan the check with the Rapid
Swipe check reader.

5. Enter the payment amount in the Amount box.

6. Review the information and click OK.

If you want to receive more than one payment at a time, the only way to do this is with RapidTuition
Autopay. 

To enter an autopay batch:
1. Open the Accounting Center.

2. Select the RapidTuition Autopay task from the Tasks Bar.

3. Choose your Run Date and add a Memo if necessary.

4. Select the customers for the autopay batch:
a. You can manually un-check each customer you do not want to include in the batch.

OR
b. You can click the Select button and filter the list by Group or Transaction Type.

http://www.childcaremanager.com/products-services/services/rapidtuition.aspx
http://www.childcaremanager.com/products-services/services/rapidtuition.aspx
http://www.childcaremanager.com/products-services/services/rapidtuition.aspx
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5. Review the batch and click Submit.

Only customers enrolled in RapidTuition with an outstanding balance will show up in the RapidTuition
Autopay window. 

What if you make a mistake and run an autopay batch too soon, or include a customer that was not
supposed to pay yet? You don't have to worry about these problems with Rapid Tuition, because they
are to simple fix. 

To stop a pending batch or transaction in autopay:
1. Open the Accounting Center.

2. Select the Rapid Tuition Autopay task from the Tasks Bar.

3. Click Stop a Pending Autopay.

4. Select the batch or transaction you wish to stop, and click the Stop Autopay Batch or the Stop
Autopay Transaction button.
a. Your autopay batches will be in the top box, and the individual transactions that make up the batch

will be in the bottom box.

5. To confirm the stop payment click Yes.

6. You can continue to stop payments or click Close to exit the window.

You cannot stop payment once it has been deposited. The ACH and Credit Card deposit dates for a
batch are listed at the top of the RapidTuition Autopay window. 
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8 Report Center

The Report Center is where you can find, modify and run all the reports found in Childcare Manager.
Knowing how to navigate and utilize the Report Center is important to viewing various types of center
information in an organized way.  

The Report Center is divided into four sections. 

1- Report List is a list of all the specific reports found in the highlighted report category.

2- Report Categories group the specific reports based on similar information. For example, all of the
reports in the Child Attendance category involve attendance information based on the children in your
center.

3- Report QuickView gives you a description of the exact information found within the report. The
Report QuickView also provides you with a list of possible filters and sorting fields for that report.

4- Report Preview gives you a preview of the first page of the report. You can cycle to other pages of
the report with the Previous Page button and the Next Page button.

The Report QuickView also contains a quick access toolbar tailored for reporting. Learning the different
functions of each button helps you get the most out of the Report Center. 
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Modify Report opens the Customize Report window, where you can filter or sort the fields of the report
highlighted in the Report List. 

Filtering allows you to customize your report to display only the information you want. For
example, you may want child attendance records for a specific class.  

1. To use a filter:
a. Click the check-box next to the appropriate filter.

i. You can use as many filters as you want.
b. Fill out the necessary information specific to that filter.

i. This information will be found to the right of the filter choices.
c. Click Run Report.

Sorting allows you to customize your report to display the information in a certain sequence.
For example, you may want child attendance records to be displayed by the sponsor's last name. 
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1. To sort your information:
a. Select the Sorting tab in the Customize Report window.
b. Highlight the appropriate sorting field from the Available Fields box.
c. Click the greater than sign (>) between the Available Fields box and the Selected

Fields box.
i. The report will sort your information in the order the fields appear in the Selected

Fields box. To change the order, you will need to remove all fields from the
Selected Fields box, and replace them using the fields in the Available Fields
box.
1. To remove all the fields in the Selected Fields box at the same time, click the

double less than sign (<<).
2. To remove a single field from the Selected Fields box, highlight the field and

click the less than sign (<).
d. When you finish selecting sorting fields, click Run Report.

Run opens the highlighted report in the Report Preview area. 

Memorize opens the Memorize Report window, where you can save the filter and/ or sorting options
from a specific report. 

1. To memorize a report:
a. Click memorize in the quick access toolbar.
b. Enter a name in the Name field.
c. Click OK.

Custom report list is a list of memorized reports for the report highlighted in the Report List. 

Print allows you to print the open report. 

Print Preview allows you to view a copy of the open report before you print it. 

Export Report allows you to save the open report to your computer. 

Email Report allows you to email the open report. 

Zoom In makes the report larger in the Report Preview area. 

Zoom Out makes the report smaller in the Report Preview area. 

Previous Page cycles to the previous page of the open report. If there is no previous page, then the
Previous Page button will do nothing. 

Next Page cycles to the next page of the open report. If there is no next page, then the Next Page
button will do nothing. 

Help opens the Report Center section of the Childcare Manager help manual.
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9 Additional Features

Congratulations you can now run your childcare facility using Childcare Manager, but don't forget to
check out all of these amazing additional features. 

The Accounting Center: Center where you keep track all your accounts payable and accounts
receivable. Understanding the Accounting Center can be a little tricky so we have included some
outside reading and viewing material you may find helpful.
o Childcare Manager Help:

Accounting Center
Accounting Basics

Chart of Accounts 
o Outside Help:

The Accounting Game by Darrell Mullis and Judith Orloff
Accounting Fundamentals on Lynda.com

The Lead Center: This new Center is a great marketing tool that lets you organize, contact and
schedule events that involve your leads. 
o Childcare Manager Help:

Lead Center:
Child Information
Lead Tasks

Users Manager: Option that lets you setup multiple user accounts where the administrator can
restrict or allow a user's access to particular applications within your center.   
o Childcare Manager Help:

Protecting Your Data
How to Utilize Users Manager

Export to Quickbooks: Function that lets you integrate your Childcare Manager data with
Quickbooks.
o Childcare Manager Help:

Exporting to Quickbooks

Rapid Tuition: A payment processing solution that is integrated with you Childcare Manager
software. RapidTuition lets you process ACH transaction, credit cards and checks. For more
information please contact customer support at 800-553-2312.  
o Childcare Manager Help:

RapidTuition

CCM Online: An group online tools that integrate with your Childcare Manager software. These tools
provide greater communication with your parents, and increases the resources your childcare facility
can use to be successful. For more information on CCM Online, please contact customer support at
800-553-2312 or visit the Childcare Manager Online website. Below is a list of CCM Online tools you
can use with your Childcare Manager.

The Parent Portal: Family Center task that helps you manage your online Parent Portal through
Childcare Manager. Registering a Parent Portal for your childcare facility gives you an easier way to
enroll children in your school, a stronger connection with your existing parents, and the parents will
have access to their personal information so they can update and add to it when it changes. For more
information please call customer support at 800-553-2312. 
o Childcare Manager Help:

http://www.lynda.com/Business-Accounting-tutorials/Accounting-Fundamentals/158665-2.html
http://www.lynda.com/
https://www.childcaremanageronline.com/
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Family Center
Family Tasks
o Parent Portal

Batch Email: Family, Child, Employee and Lead Center task that lets you email multiple families or
employees at the same time. Great way to communicate with your employees or the parents of a
single classroom. 
o Childcare Manager Help:

Batch Emailing

Group Text Messaging: Family, Child and Employee Center task that lets you send text messages
to multiple families or employees at the same time. Another great communication tool. 
o Childcare Manager Help:

Send Group Text Messages 
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